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Notă: Itemii au o singură  variantă corectă. Timp de lucru 90 minute. Se acordă două puncte 
pentru fiecare item rezolvat corect.

TEST GRILĂ

1. Pentru a  seta o traiectorie particularizată atunci când vrem să animăm un obiect folosim:
a) Expunere 
Diapozitive (Slide 
Show) > Setari 
Actiune (Action 
Settings) > Adaugare 
Efect (Add 
effect)>Desenare Cale 
Particularizată (Draw 
motion path)

b) Intrumente (Tools)> 
Particularizare (Customize)> 
Adăugare Efect (Add effect)>  
Căi de mişcare (Motion 
path)> Desenare Cale 
Particularizată (Draw custom 
path)

c) Expunere Diapozitive
(Slide show) > Animatie 
particularizată (Custom 
animation) > Adăugare 
Efect (Add effect)>Căi de 
mişcare (motion paths)
>Desenare Cale 
Particlarizată (Draw 
custom path)

d) Expunere 
Diapozitive (Slide 
show) > Expuneri 
particularizate (Custom 
show) > Adăugare 
Efect (Add effect)>Căi 
de mişcare (motion 
paths)>Desenare Cale 
Particularizată (Draw 
custom path)

2. Pentru a crea o comandă automată pentru efecturea unor funcţii simple într-o prezentare  folosim:
a) Instrumente
(Tools)> Inregistrarea 
unei macrocomenzi 
(Record macro)

b) Instrumente (Tools)> 
Atelier partajat (Shared 
workspace) 

c) Fişier (File)> Proprietăţi
(Properties) 

d) Instrumente (Tools) 
>Particularizare
(Customize) 

3. Pentru a crea un cuprins automat într-o prezentare PowerPoint folosim:
a) opţiunea Slide 
Show (Expunere 
diapozitive)

b) opţiunea Rehearse 
Timings (Programarea 
repetiţiilor)

c) opţiunea Common Task 
(Taskuri comune)

d) opţiunea Summary 
Slide (Diapozitiv 
rezumat) 

4. Inserarea unor butoane într-un diapozitiv se face din meniul:
a) Insert (Inserare) b) Edit (Editare) c) Format (Formatare) d) Slide Show 

(Expunere diapozitive)

5. Pentru a  realiza un buton într-un diapozitiv,  buton ce va ajuta la încheierea expunerii folosim:
a) Expunere 
diapozitive (Slide 
Show) >Setari actiune
(Action Settings) > 
Executare 
macrocomanda (Run 
macro)> Comanda 
creată anterior

b) Expunere diapozitive
(Slide Show) >Butoane  
acţiune (Action 
Buttons)>Hyperlink 
catre>"Incheierea expunerii"
(End show)

c) Expunere diapozitive
(Slide show)> Animatie 
particularizata (Custom 
animation) > Hyperlink 
catre> "Incheierea 
expunerii".

d) Expunere diapozitive
(Slide Show) > Butoane 
de acţiune (Action 
Buttons)> Executare 
macrocomandă (Run 
macro)>Comandă
creată anterior

6. Alegerea unui tip predefinit de diapozitiv se face din meniul Format, alegând:
a) Slide Layout
(Aspect diapozitiv)

b) Animation Scheme (Efecte 
de animaţie)

c) Background (Fundal) d) Font
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7. Pentru a uni două prezentări Power Point într-o singură prezentare folosim:
a) Inserare (Insert)> 
Diapozitive din fişiere 
(Slides from files)

b) Editare (Edit)> Lipire 
specială (Paste special)

c) Fişier (File)>Proprietăţi 
(Properties)

d) Intrumente (Tools)> 
Comparare şi îmbinare 
prezentări (Compare 
and merge 
presentations) 

8. Care dintre următoarele enunţuri referitoare la utilizarea instrumentului Pen Color este adevărată?
a) se poate alege în 
faza de proiectare a 
prezentării

b) se poate alege în 
momentul derulării 
prezentării (modul Slide 
View) 

c) stabileşte intervalul de 
timp dintre două afişări de 
diapozitive

d) se poate alege în 
modul de vizualizare 
Slide sorter (Sortare 
diapozitive)

9. Animaţia particularizată poate să includă:
a) Entrance, Exit 
effects (efecte de 
intrare, ieşire)

b) Emphasis effects, Motion 
paths (efecte accent, căi de 
mişcare)

c) variantele a şi b d) niciuna dintre 
variante

10. Care afirmaţie nu este adevărată, în legătură cu modul de vizualizare a prezentării Slide Sorter View
(Sortare diapozitive):
a) se poate edita textul 
din slide

b) se poate elimina un slide c) se pot reordona 
slide-urile

d) se poate insera un 
slide nou

11. Parametrul COLLSPAN permite:
a) extinderea unei 
celule pe mai multe 
coloane

b) extinderea unei celule pe mai 
multe linii

c) definirea spaţiului 
dintre celule

d) definirea spaţiului 
lăsat dintre conţinutul 
celulei şi chenar

12. Ce rezultat obţineţi dacă inseraţi tag-ul <i><b>Concursul</b></i><u>CIA</u> SUCEAVA<b>2009</b>
a) Concursul CIA
SUCEAVA 2009

b) Concursul CIA SUCEAVA 
2009

b) Concursul CIA
SUCEAVA 2009

b) Concursul CIA
SUCEAVA 2009

13. Care este tag-ul corect pentru a insera un hypertext ?
a) <link> Acesta este 
un link

b) <link> Acesta este un link 
</link>

c) <a src 
=”imagine.gif”> Acesta 
este un link

d) <a href
=”fişier.htm”> Acesta 
este un link </a>

14. Dacă pe magistrala de date se transmite câte un bit pe fiecare linie de date atunci transmiterea este:
a) în paralel b) în serie c) în reţea d) nici una dintre 

variante

15. Dacă o reţea de calculatoare respectă topologia de tip stea, reţeaua de calculatoare devine inutilizabilă 
dacă:
a) conexiunea dintre 
două calculatoare 
alăturate nu 
funcţionează

b) dispozitivul central nu 
funcţionează

c) această topologie de reţea 
permite funcţionarea 
permanentă a reţelei indiferent 
de evenimentele care pot apare

d) cablul de legatură 
dintre două calculatoare 
este întrerupt
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16. Care dintre următoarele butoane NU se găsesc într-o casetă de dialog ?
a) buton radio b) buton  de închidere

(Close)
c) buton de tip casetă de 
validare (Check Box)

d) buton  de restaurare
(Restore)

17. Pentru a afişa sinonimele respectiv antonimele unui cuvânt selectăm:
a) Tools (Instrumente) 
Language 
(Limbă)Set 
Language (Stabilire 
limbă)

b) Tools (Instrumente) 
Language 
(Limbă)Thesaurus (Lexicon)

c) Format 
(Format)Change 
Case (Modificare după 
caz)

d) Tools 
(Instrumente)
Spelling and grammar
(Corectare ortografică 
şi gramaticală)

18. Care dintre variantele de mai jos, referitoare la funcţia Track Changes (Urmărire modificare) este 
adevărată?
a) este utilă atunci 
cănd mai multe 
persoane lucrează la 
editarea unui 
document

b) un utilizator poate accepta sau 
refuza modificările făcute de un 
alt utilizator pe documentul creat 
de el

c) poate fi utilizată 
atunci când se combină 
două documente

d) toate variantele sunt 
adevărate

19. Un tabel Word conţine într-o celulă un câmp calculat cu ajutorul opţiunii Formula (Formulă). Dacă se 
modifică datele referite de formulă atunci valoarea calculată:
a) nu se actualizează 
automat

b) se actualizează automat c) se actualizează 
selectând valoarea din 
celula care conţine 
formula şi apăsând
tasta F9

d) se actualizează 
selectând celula care 
conţine formula şi 
apăsând tasta F10

20. Câte funcţii imbricate se pot regăsi intr-o formulă Excel ?
a) 7 b) 9 c) 12 d) 10

21.  În domeniul B4:B11 avem un set de valori numerice. Aceste valori trebuie înmulţite toate cu valoarea 5, 
iar rezultatele înmulţirilor trebuie plasate în domeniul C4:C11. Valoarea 5 se găseşte în celula A1. Care este 
formula corectă pe care trebuie să o scriem în celula C4 pentru ca prin copiere pe coloană, să rezulte valorile 
corecte?
a) =B4*A1 b) =$B4*A1 c) =B4*$A1 d) =B4*$A$1

22. Pentru a realiza o situaţie a elevilor unei clase se trec într-o foaie de calcul următoarele date: nume(A), 
med_romana(B), med_fizica(C), med_generala(D), situaţie(E). Un elev este considerat promovat dacă toate 
mediile sunt mai mari sau egale cu 5, altfel el este corigent. Ce formulă se va aplica în celula E2?
a) 
=IF(AND(B2<5;C2<5;D
2<5;E2<5);”corigent”;
”promovat”)

b) 
=IF(OR(B2<5;C2<5;D2<5;
E2<5);”corigent”;
”promovat”)

c) 
=IF(OR(B2<5;C2<5;D
2<5;E2<5);”promovat”
;”corigent”)

d) 
=IF(OR(B2>4;C2>4;D2>
4;E2>4);”corigent”;
”promovat”)

23. Dacă dorim să îngheţăm atributele coloanelor din rândul 3 şi atributele rândurilor din coloana A, pe ce 
celulă trebuie să facem clic înainte de a executa comanda îngheţare panouri?
a) B4 b) A1 c) B3 d) B2
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24. Care din următoarele funcţii Excel concateneză textele specificate ca argumente?
a) 
CONCAT(text1;text2)

b) 
CODE(text1;text2)

c)
CONCATENATE(text1;text2)

d) 
EXACT(text1;text2)

25. Stilul Comma(0) (virgulă(0)):
a) adaugă două
zecimale şi introduce
virgula în calitate de 
separator de mii

b) rotunjeşte zecimalele şi
introduce virgula în calitate
de separator de mii

c) înmulţeşte numărul cu 
100 şi adaugă simbolul de 
procent

d) adaugă trei
zecimale şi introduce
virgula în calitate de 
separator de mii

26. Mesajul de eroare #VALUE! apare când: 
a) formula se referă la o 
celulă inexistentă

b) formula se referă la o 
celulă în care nu există încă
nici o valoare

c) în formula s-a utilizat o 
denumire pe care Excel nu 
o recunoaşte

d) valoarea nu este de
tipul corespunzator
argumentului

27. Care din următoarele funcţii au ca argument o plajă discontinuă de celule? 
a) 
=SUM(A2:A7)

b) 
=MAX(59;36;84)

c)
=SUM(A2:A7;A9;A11:A20)

d)
 =IF(A1=A2;"Bun";Rau")

28. Ce returnează funcţia  =ROMAN(1976) ?
a) MMIX b) MCMLXXXVI c) MMCMLXXVI d) MCMLXXVI

29. Care este efectul produs de scrierea într-o celulă a unei foi de lucru a următoarei formule de calcul ? 
=(ROUND(1575,368;2)+POWER(3;5))* PRODUCT(4;5;0)
a) 1818,37 b) 0 c) 1575,368 d) 1818,368

30. Apelarea funcţiei MEDIAN în formatul următor =MEDIAN(A1:F1) pentru valorile din figura de mai jos,  

va avea ca rezultat afişarea valorii: 
a)  3 b)  4 c) 2 d)  3,5

31.  Apelarea funcţiei HARMEAN în formatul următor =HARMEAN(A1:G1) pentru valorile din figura de 
mai jos,  va avea ca rezultat afişarea valorii: 

a) 1,57 b) 1,4 c) 1,5 d) 2

32. Ce afişează    =POWER(2,FACT(INT(SIGN(RAND()))))?
a) 1 b) 2 c) 4 d) 8

33. Care este valoarea obţinută prin aplicarea funcţiei  =COUNTA(B1:I2) ?

  
a) 11 b) 5 c) 16 d) 8
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34. Formula: =IF(LEN(A1:A5)>=3,"adevarat","fals") va avea ca efect:
a) verificarea numerelor 
din domeniul A1:A5 şi 
înlocuirea celor  >=3 cu 
mesajul „adevarat”

b) înlocuirea notelor cu 
mesajele „adevarat”/ „fals”

c) înlocuirea cuvintelor din 
domeniul A1:A5 cu 
mesajul „fals”

d) afişarea mesajului 
„adevarat”/„fals” dacă 
lungimea cuvintelor  
din domeniul A1:A5 
este  >=3

35. Formula =MID("Concursul National de Informatica Aplicata",1,FIND(" ","Concursul National de 
Informatica Aplicata ")) are ca efect:
a) afişarea textului 
„Concursul National de 
Informatica Aplicata”

b) afişarea textului 
„Concursul”

c) afişarea textului 
„Informatica”

d) afişarea textului 
„Informatica Aplicata”

36. Formula: =IF(RIGHT(A2,1)="a",CONCATENATE(A2,"escu"))
a) înlocuieşte şirul de 
caractere din celula A2 
cu şirul „escu”

b) adaugă în faţa şirului de 
caractere din celula A2 şirul 
„escu”

c) modifică şirul de 
caractere din celula A2, 
dacă acesta are sufixul „a”  
adăugând sufixul „escu”

d) modifică şirul de 
caractere din celula 
A2, dacă acesta are 
sufixul „a”  adăugând 
prefixul „escu”

37. Ce va afişa funcţia  =T(A1) dacă în celula A1 introducem numărul 2009 ?
a) 2009 b) #VALUE! c) nu va afişa nimic d) 2010

38. Apelarea  funcţiei ADRESS în formatul următor =ADDRESS(10;2;1;FALSE;"EleviNote") va avea ca 
rezultat:
a) EleviNote!$B$10 b) EleviNote!R10C2 c) EleviNote!C$2 d) EleviNote!R10C3

39. Apelarea funcţiilor MIN şi CHOOSE în formatul următor 
=MIN(CHOOSE(3;A1:A6;B1:B6;C1:C6;D1:D6)) pentru valorile din figura alăturată, va avea ca rezultat 

afişarea valorii:

a) 0 b) 1 c) 2 d) 3

40. În Access funcţia TRIM(sir):
a) elimină spaţiile 
situate în afara şi în 
interiorul şirului

b) elimină spaţiile situate în
afara şirului

c) elimină spaţiile situate 
în interiorul şirului

d) elimină spaţiile 
situate în stânga şirului

41. Alegeţi varianta care conţine numai funcţii uzuale pentru date numerice:
a) ISNUMERIC(), 
RND(), ABS()

b) RND(), ABS(), & c) ABS(), NOW(), INT() d) ISNUMERIC(), 
RND(), STR()
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42. Într-o bază de date ce conţine tabelele Clase şi Elevi pentru a obţine informaţii numai despre clasele care 
au introduse date despre elevii lor proiectăm o asociere de forma:
a) Left join b) Right join c) Inner join d) toate variantele

43. Allow Zero Length (permite lungime zero) se aplică datelor:
a) Currency şi 
Autonumber (Moneda şi 
Autonumerotare)

b) Memo şi Currency 
(Memo şi Moneda)

c) Text şi Memo (Text si 
Memo)

d) Number şi Memo 
(Numar şi Memo)

44. Modificările efectuate în regimul Datasheet View (Foaie de date):
a) nu afectează 
ordinea şi 
caracteristicile 
câmpurilor stabilite 
în regimul Design 
View (Proiectare)

b) afectează ordinea şi 
caracteristicile câmpurilor 
stabilite în regimul Design 
View (Proiectare)

c) stabileşte 
caracteristicile câmpurilor 
stabilite în regimul 
Design View (Proiectare)

d) anulează 
caracteristicile 
câmpurilor stabilite în 
regimul Design View 
(Proiectare)

45. Indexarea tabelelor oferă avantajele:
a) posibilitatea folosirii 
expresiilor drept criteriu 
de ordonare

b) selectarea după criterii 
unice

c) actualizarea  promptă a 
indecşilor odată cu datele 
propriu-zise

d) toate variantele

46. În proiectarea unei relaţii este adevărată propoziţia:
a) relaţia este n-n b) ambii indecşi trebuie să 

aibă acelaşi tip şi aceeaşi 
expresie de indexare

c) tabela nu poate fi legată 
de mai multe tabele prin 
chei distincte

d) legăturile dintre
tabele nu se pot edita

47. Dacă într-o interogare dorim să obţinem elevii cu media necompletată vom pune pe coloana media:
a) IS NOT NULL b) media=0 c) IS NULL d) media!=0

48. Dacă dorim ca filtru aplicat asupra datelor să fie variabil vom introduce numele variabilei între:
a) paranteze rotunde b) acolade c) ghilimele d) paranteze drepte 

49. Care din următoarele variante nu este un model conceptual al bazelor de date:
a) modelul ierarhic b) modelul tabel c) modelul reţea d) modelul relaţional

50. Utilitarul care realizează grafice este apelat din:
a. Database (Bază de 
date)> Report (Raport)> 
New (Nou)> Chart 
Wizard (Expert 
diagramă) 

b. Database (Bază de date)> 
Query (Interogare)> New
(Nou)> Chart Wizard
(Expert diagramă)

c. Database (Bază de date)> 
> Report (Raport)> Chart 
Wizard (Expert diagramă)
> New (Nou)

d. Database (Bază de 
date)> Query 
(Interogare)> Chart 
Wizard (Expert 
diagramă) >New
(Nou)


